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USB Turntable

Model: ITUT-5000
ITUT-5000 is a part of ITCDS-6000.

Instruction Manual

PLEASE READ THIS INSTRUCTION MANUAL CAREFULLY BEFORE USE

AND KEEP IT FOR FUTURE REFERENCE.



IMPORTANT SAFETY INSTRUCTIONS

1. Read these instructions — All the safety and operating instructions should be read before this
product is operated.

2. Keep these instructions — The safety and operating instructions should be retained for future
reference.

3. Heed all warnings — All warnings on the appliance and in the operating instructions should be
adhered to.

4. Follow all instructions — All operating and use instructions should be followed.

5. Do not use this apparatus near water — The appliance should not be used near water or
moisture — for example, in a wet basement or near a swimming pool, and the like.

6. Clean only with dry cloth.

7. Do not block any ventilation openings. Install in accordance with the manufacturer’s
instructions.

8. Do not install near any heat sources such as radiations, heat registers, stoves, or other
apparatus (including amplifiers) that produce heat.

9. Do not defeat the safety purpose of the polarized or grounding plug. A polarized plug has two
blades with one wider than the other. A grounding plug has two blades and a third grounding
prong. The wide blade or the third prong is provided for your safety. If the provided plug does
not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10. Protect the power cord from being walked on or pinched particularly at the plugs,
convenience receptacles, and at the point where they exit from the apparatus.
11. Only use attachments/accessories specified by the manufacturer.

12. Use only with the cart, stand, tripod, bracket, or table specified by the
manufacturer, or sold with the apparatus. When a cart or rack is used, use
caution when moving the cart/apparatus combination to avoid injury from

tip-over.
13. Unplug the apparatus during lighting storms or when unused for long periods of time.

14. Refer all servicing to qualified personnel. Servicing is required when the apparatus has been
damaged in any way, such as power supply cord or plug is damaged, liquid has been spilled or
objects have fallen into the apparatus has been exposed to rain or moisture, does not operate
normally, or has been dropped.

15.

RISK OF ELECTRIC SHOCK
DO NOT OPEN

AVERTISSEMENT:

RISQUE DE CHOC ELECTRIQUE—NE PAS OUVRIR.

-This lightning flash with arrowhead symbol within an equilateral triangle is intended to alert the

user to the presence of non-insulated “dangerous voltage” within the product’s enclosure that
may be of sufficient magnitude to constitute a risk of electric shock.

-Warning: To reduce the risk of electric shock, do not remove cover (or back) as there are no



user-serviceable parts inside. Refer servicing to qualified personnel.

-The exclamation point within and equilateral triangle is intended to alert the user to the
presence of important operating and maintenance instructions in the literature accompanying
the appliance.

16. This equipment is a Class II or double insulated electrical appliance. It has been

designed in such a way that it does not require a safety connection to

electrical earth.

This equipment is a Class Il or double insulated electrical appliance. It has been designed in such

a way that it does not require a safety connection to electrical earth.

17. The mains plug is used as disconnect device, the disconnect device shall remain readily

operable.

18. WARNING
To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.
The apparatus shall not be exposed to dripping or splashing and that no objects filled with
liquids, such as vases, shall not be placed on apparatus.

19. The use of the equipment in moderate climate.

20. The ventilation should not be impeded by covering the ventilation openings with items, such

as newspapers, table-cloths, curtains, etc.

21. No naked flame sources, such as lighted candles, should be placed on the apparatus.

22. The symbol with ™~ Indication AC voltage



Precautions

Safety Information-caution:

1. In order to shut off power to this product completely, unplug the power cord from the wall
outlet. Be sure to unplug the unit if you do not intend to use it for an extended period of time,
such as during a vacation.

2. Use of controls, adjustments and performance of procedures other than those specified herein
may result in hazardous radiation exposure.

3. To prevent electric shock, match wide blade of plug to wide slot, fully insert.

4. If this product is experience problems during operation, contact qualified service centers, and
do not use the product in defective states.

Safety Precautions

WARNING:

To reduce the risk of fire or electric shock, do not expose this appliance to rain or
moisture.

CAUTION:

Use of controls or adjustments or performance of procedures other than those
specified may result in hazardous radiation exposures.

CAUTION

RISK OF ELECTRIC SHOCKS - DO NOT OPEN!

To reduce the risk of electric shock, do not remove cover or back.

No user serviceable parts inside. Refer servicing to qualified service personnel.

The light flash with arrowhead symbol, within an equilateral triangle, is

A intended to alert user to the presence of non-insulated “dangerous
voltage” within the product’s enclosure that may be of sufficient

magnitude to constitute risk of electric shock to persons.

The exclamation point within an equilateral triangle is intended to alert
user to the presence of important operating and maintenance

(servicing) instructions in the literature accompanying the appliance.

(See markings on the back of the unit.)



Before Use

1. Choose unit installation location carefully. Avoid placing it in direct sunlight or close to a
source of heat. Also avoid locations subject to vibrations and excessive dust, cold or moisture.
Keep away from sources that hum, such as transformers or motors.

2. Do not open the cabinet as this may result in damage to the circuitry or electrical shock. If a
foreign object should get into the set, contact your dealer.

3. Be sure not to handle record with dirty fingers. Never play a record that has a crack on the
surface.

4. When removing the power plug from the wall outlet, always pull directly on the plug, never
pull the cord.

5. To protect the stylus, don’t forget to put on the white protective needle cover after use.

6. Do not attempt to clean the unit with chemical solvents as this might damage the finish.

Use a clean, dry cloth.

7. In order to shut off the power to this product completely, unplug the power cord from the wall
outlet. Be sure to unplug the unit if you do not intend to use it for an extended period of time,
such as a vacation.

8. Keep this manual in a safe place for future reference.

How to Replace the Turntable Stylus (Needle)

Removing old stylus

1. Set a screwdriver at the tip of the stylus and push
down in the direction “A”.

2. Remove the stylus by pulling it forward and down.

Installing a new stylus

1. Hold the tip of the stylus and insert the other edge [c) (
by pressing in the direction “B”.

o

Guide Pins (inside)

2. Push up in the direction “C” until it locks at the tip.
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PART I: Main Function

Line Out

1. Disconnect the AC power cord from the household outlet to turn the unit OFF.

2. Connect the RCA line out jacks to the auxiliary input sockets of your home amplifier device.
Make sure to match the socket colors with the jack colors.

3. Connect the unit’s power cord to the household outlet. Also, power on your amplifier device
and adjust its volume level.

Phonograph

1. Connect the AC plug to the household outlet.

2. Press the power button to turn on the unit.

3. Put a record on the turntable. Remember to use the 45 RPM adaptor located on the bottom
left corner when playing a 45 RPM record.

4. Remove the white plastic needle cover. Keep the needle cover in a safe and accessible place
for future use.

5. Select the speed according to the record you are playing.

6. Lift and move the tone arm over the turntable. Record will start spinning and place the tone
arm in desired position to start playing music.

NOTE:
It is strongly recommended to play records with the transparent dust cover closed. Also
please do not place anything on top of the dust cover especially while playing a record.

7. To pause or stop playing, you need to lift and move the tone arm back to the tone arm rest
manually.

8. When the end of the record is reached, the tone arm and rotation stop. Lift the tone arm and
place it on the tone arm rest manually.

9. Remember to use the white plastic needle guard to protect the stylus and unplug the unit.

AUX-IN 2 Function (Turntable Setup)

Before use, make sure both the ITCDS-5000a and ITUT-5000 are plugged into a power source.

1. To connect the turntable unit (ITUT-5000) to the main speaker system (ITCDS-5000a), plug the
included RCA Cable into the Line Out jacks (Aux-In 2) into the back of the main speaker
system. Make sure that the red RCA Cable is inserted into the red jack and the white RCA
Cable is inserted into the white jack.

2. Use the other end of the RCA Cable to connect to the back of the turntable unit, again being
sure that the RCA Cable is plugged into the correct color coded jack.

3. Turn on both the ITCDS-5000a and the ITUT-5000 using their respective power buttons.

4. Press the Function button on main speaker system to select the AUX-IN 2 function.

5. Follow turntable operation steps for audio playback.



PART IllI: Audacity Software
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The provided CD disc contains the following software:

(1)Audacity_for_mac--------- For Mac (see page 22)

(2)Audacity_for_win --------- For Windows

The software is compatible with Window XP, VISTA, 7 and 8, 10 requires appropriate drives and Mac.

NOTE:

- Read about Audacity on Windows 8, 7 and Vista. Windows 2000, NT, and 95 are not supported.

-Windows 10 is supported, but subject to all enabled devices having Windows 10-compatible drivers designed for the
device. This should be the case for the built-in sound device of a new computer that came with Windows 10. Please
see our Windows 10 page for solutions if you encounter problems. We hope to improve our Windows 10 compatibility
with older devices in a future release.

-A CPU that supports SSE2 is required (any CPU made after 2003 should support this). Please use

the legacy Audacity 2.0.6 version if your machine lacks SSE2 support.

- Audacity for Mac is a Universal Binary for OS X 10. 6 and later. Audacity runs best with at least 1 GB RAM and a 1
GHz processor (2 GB RAM/2 GHz on OS X 10.7 and later).

- For lengthy multi-track projects, we recommend a minimum of 2 GB RAM and 2 GHz processor (4 GB RAM on OS X
10.7 and later).

- The 2.1.1 release was the final release for PPC Macs.

=

Because of the variation of different operation systems, some of the interface may not be the same as below.

Audacity Installation and USB Connection

Connect one end of USB cable to the turntable and the other end into your computer. Then connect the AC power
cord of the turntable.

Audacity for Windows

Installing the Audacity Software

1. Please insert the Audacity software disk that comes with your unit. Go to My Computer and double click the CD
ROM Drive.
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@' Music
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2. Select Audacity-for-win for window system.

Audacity
Audacity-for-mac

Audacity-for-win

3. Double click the audacity-win-2.1.2 to install the audacity software.

D

audacity-wi
n-21.2

4. Select the setup language first and click on OK to continue.



Select Setup Language *%  © L. ]
—_—

Select the language to use during the
installation:

[Engisn v)

Note: The language choice in the Windows EXE Audacity installer only selects the language for the installer.
5. The Audacity Setup Wizard will appear. Click on Next to install the software.
@ Setup - Audacity® o=l X

Welcome to the Audacity® Setup
Wizard

This will install Audacity 2.1.2 on your computer.

Itis recommended that you dose all other applications before

e continuing.
A“da[“lty Click Next to continue, or Cancel to exit Setup.

o

6. Continue to click on the Next buttons.

& Setup - Audacity® = XT ]
Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

/Audacity® is free, open source software for recording and editing -
sounds. It is available for Mac OS X, Microsoft Windows, GNU/Linux,

and other operating systems. Learn more about Audacity... Also check

our Wiki and Forum for more information.

License: Audacity is free software. You may use it for any personal,
commercial or educational purpose, including installing it on as many |=
different computers as you wish. Audacity is licensed under the terms

of version 2 of the GNU General Public License (GPL) as published by the
Free Software Foundation. The full text of the license is also available
when running Audacity, via the Help menu > About Audacity... command

> GPL License tab.

[ < Back ][ Next > ][ Cancel l

& Setup - Audacity® = x|

Select Destination Location
Where should Audacity® be installed?

J Setup will install Audacity® into the following folder.

To continue, dick Next. If you would like to select a different folder, dick Browse.

C:\Program Files (x86)\Audacity

At least 56.6 MB of free disk space is required.

[ <Back ][ Next > ][ Cancel ]

&) Setup - Audacity® = 2|

Select Additional Tasks
Which additional tasks should be performed? m

Select the additional tasks you would like Setup to perform while installing Audacity®,
then dick Next.

Additional icons:

Create a desktop icon

[¥] Reset Preferences

< Back ][ Next > ][ Cancel




7. Click on the Install button to start installation.

& Setup - Audacity® [= 2%
Ready to Install
Setup is now ready to begin installing Audacity® on your computer.

Click Install to continue with the installation, or dick Back if you want to review or
change any settings.

Destination location: -
C:\Program Files (x86)\Audacity

Additional tasks:
Additional icons:
Create a desktop icon

Reset Preferences
< »
< Back ][ Install ] [ Cancel ]
@ Setup - Audacity® [=]E] ¥ ]
Installing

Please wait while Setup installs Audacity® on your computer.

Extracting files...

C:\Program Files (; \Audadity \help\manual\m\mages\0\0f h.png

==

Cancel

8. Click on Next to continue.

& Setup - Audacity® = J
Information
Please read the following important information before continuing.

When you are ready to continue with Setup, dick Next.

Audacity(R): A Free, Cross-Platform Digital Audio Editor
WWW: http: //audadityteam.ora/

\We welcome feedback on Audacity, suggestions for new or improved features,
bug reports and patches at:
feedback@audacityteam.org .

Personal support with Audadity is not provided by e-mail, but on our Forum:
http: //forum.audacityteam.ora/ .

|Audacity is copyright (c) 1999-2015 by Audacity Team. This copyright notice
applies to all documents in the Audacity source code archive, except as
lotherwise noted (mostly in the lib-src subdirectories).

9. Click on Finish to complete installation.

@ Setup - Audacity® L=

Completing the Audacity® Setup
Wizard

W Setup has finished installing Audacity® on your computer. The
application may be launched by selecting the installed icons.

. Click Finish to exit Setup.
u aCl‘ly [¥] Launch Audadty

10. You can now open the Audacity software and start recording your files.

Note:

1. Once you set up Audacity, you do not need to re-set it with each use.

2. The “Audacity-win-2.1.2.exe” (helpfile included) is available for Windows 8/ Windows 7/ Windows 10
requires appropriate drivers / Windows Vista/ Windows XP.

3. If you cannot run the exe document, please go to the website below and download the file from it directly.

http://www.audacityteam.org/download/windows




4. Users upgrading to this release from Audacity 2.0.5 or earlier who had FFmpeg installed will see
a notice that FFmpeg needs to be reconfigured.

Please visit http://manual.audacityteam.org/o/man/fag_installation_and_plug_ins.html#ffdown for a link to the
recommended 2.2.2 version of FFmpeg for Windows and Mac OS X, and for information for Linux.

5. The Windows installer for 2.0.x versions will replace legacy 1.2.x or any previous 2.0.x installation, but install
alongside legacy 1.3.x Beta versions. It is strongly recommended to uninstall previous Beta versions before installing
current Audacity.

6. Audacity 2.1.2 requires the CPU to support the SSE2 instruction set which should be available on any Intel
hardware produced after 2001 and any AMD hardware produced after 2003. To check what SSE levels your CPU
supports, you can install CPU-Z. If your hardware only supports SSE, you may download Audacity 2.0.6

from http://www.oldfoss.com/Audacity.html.

7. Users on Windows XP: You may see "Entry Point Not Found" when first launching Audacity after installation. This
error occurs if you are running less than the latest "Service Pack" of updates for your Windows XP system.

Please see http://manual.audacityteam.org/o/man/faq_installation_and_plug_ins.html#entry_point

for how to install the latest Service Pack and for advice about the potential security risks of running XP now that
Microsoft no longer supports it.

8. On first use of Audacity you need to confirm or cancel the Register Effects dialog for detected effects before you
can launch Audacity. (For additional information, please visit the website at

http://manual.audacityteam.org/o/man/effects preferences.html#register)

Configuring Audacity for Microsoft Windows

Audacity Interface
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Audacity Control Buttons

Use the attribute controls button at the top of the screen to go to beginning, Pause, Play, Stop, Record etc. Use the
File, Edit, View, Transport, Tracks, Generate, Effect and Analyze menus to Save, Export, and edit the music.

1. Click the (@) button to pause the recording;
. Click the (@) button to play;

. Click the (@) button to stop the recording;

. Click the (@) button to skip to start;

. Click the (@) button to skip to end;

. Click the (@) button to record;

. Adjust the input volume;

© N o g A~ O N

. Adjust the output volume;
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Audacity Preferences

1. Click the “Edit” on the Audacity interface, select “Preferences”.

File . View Transport Tracks Generate Effect An
Undo Ctr+Z I
Redo adsy  |: P
‘M

Cut Cerl+X
Delete Ctrl+K

Copy Cirl+C
Ctrl+V
Ctrl+D

Paste

Duplicate

Remove Special
Paste Text to New Label Ctrl+Alt+V
Clip Boundaries
Labeled Audio
Select

Find Zero Crossings z

Move Cursor

Region Save

Region Restore

Play Region

In the pop-up window of the Audacity Preferences, tabs of Devices, Playback, Recording, Quality, Interface, Tracks,
Spectrograms, Import / Export, Extended Import, Projects, Libraries, Directories, Warnings, Effects, Keyboard, Mouse
and Modules are listed on the left side of the window as shown in the picture below.

& Devices Interface

Host: |MME |

- Playback

- Recording
- Quality

- Interface Playback
Tracks

Using: PortAudio V19-devel (built Jan 9 2016 12:36:32)

Device: iRealtek High Definition Audio v ‘

. Spectrograms
- Import / Export Recording
- Extended Import
- Projects
.- Libraries Channels: ‘ 2 (Stereo)
- Directories
- Warnings
- Effects
- Keyboard
- Mouse
- Modules

Device: ‘ 3- USB PnP Audio Device

2. Click ‘Devices’ on the left side and detailed contents of the Devices will appear on the right hand side of the
interface.

Click the « arrow on “Device” below Playback and choose “Realtek High Definition Audio”

or “Microphone Sound Mapper- Output”.

Click the + arrow on ‘Device’ below ‘Recording’ and choose “USB PnP Audio Device'.

Click the v arrow on ‘Channels’ to select ‘2(Stereo)’. Do not click OK until you finish all of the settings.

Note: If you cannot find the " USB PnP Audio Device " in the Device list, close the Audacity Software and re-open and
try again.

Windows Vista and later call most USB external devices "microphones” but Windows XP and earlier do not. Some
higher-end USB recording interfaces may appear as their explicit manufacturer's name.

11



i~ Playback
Recording
Quality

- Interface

&= Tracks

i Spectrograms

= Import / Export

' Extended Import

- Projects
Libraries
Directories

-~ Warnings
Effects
Keyboard
Mouse
Modules

Interface

Host: | MME v
Using: PortAudio V19-devel (built Jan 9 2016 12:36:32)
Playback

Device: Realtek High Definition Audio v
Recording

ce: 3- USB PnP Audio Device

Channels: 2 (Sterec)

r OK

Cancel

- Quality
-Interface
=) Tracks
Spectrograms
= Import / Export
- Extended Import
- Projects
- Libraries
-- Directories
Warnings
Effects
Keyboard
Mouse
- Modules

3. Click ‘Recording’ on the left side and the detailed contents will display on the right side.
Click the checkbox beside ‘Software Play through: Listen while recording or monitoring new track’.
Click the checkbox beside ‘Sound Activated Recording’ and adjust the Sound Activation Level (dB) to -36.

NOTE: Once the ‘Sound Activated Recording’ is selected, the Pause button will not work during recording. You can
Click “Interface” on the left side to select Sound Activation Level.

Playthrough
[ ] Overdub: Play other tracks while recording new one

BEoftware Playthrough: Listen while recording or monitoring new track
(uncheck when recording “sterec mix”)

Latency

Audio to buffer:

100 | milli ds (hig

Latency correction: -130  milli gative = =)

nd Activated Recording

Sound Activation Level (d o

OK

Devices
-~ Playback
-~ Recording

Qualif
<";_b e
$ T_ru

- Spectrograms
- Import / Export
' Extended Import
— Projects
Libraries
- Directories

- Warnings
Effects
- Keyboard

EToolbar |
R4 Show 'How to Get Help' dialog box at program start up
e ———
-60 dB (PCM range of 10 bit samples)
6-d8-{shallow range for high-ampli
-48 dB (PCM range of 8 bit samples)
60 dB (PCM range of 10 bit samples)
-72 dB (PCM range of 12 bit samples)
Behaviors -84 dB (PCM range of 14 bit samples)
- -96 dB (PCM range of 16 bit samples)
[]Beep on compledt -120 dB (approximate limit of human hearing)
[[]Show track name -145 dB (PCM range of 24 bit samples)
[[]Retain labels if sel snaps to a 1a ge

Meter dB rarnge:

Language:
Location of Manual:

4. Before exporting a MP3 file, you need to find ‘lame’ first. If the program does not show the MP3 Library, make sure
the Audacity driver disc is inside your computer.
Click ‘Libraries’ on the left side, then in ‘MP3 Export Library’ interface, click ‘Locate...’ button to find ‘lame_enc.dIl’.
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- Devices MP3 Export Library
- Playback MP3 Library Version: MP3 export library not found

Recording
- Quality

Interface LAME MP3 Library:  Download
- Tracks
- Spectrograms FFmpeg Import/Export Library

& Import / Export FFmpeg Library Version: FFmpeg library not found

- Extended Import »
Projects FFmpeg Library: Locate...

FFmpeg Library: | Download
-- Directories

Warnings

- Keyboard
Mouse
- Modules

5. You can download the ‘lame’ software from the website.
Click ‘Download’ and a website will be opened automatically.

Devices MP3 Export Library
- Playback MP3 Library Version: MP3 export library not found

Recording MP3 Libr. —]
- Quality bl VP2
Interface LAME MP3 u‘me. Download D
- Tracks

- Spectrograms FFmpeg Import/Export Library
Import / Export FFmpeg Library Version: FFmpeg library not found
- Extended Import

)
i}

m
I}

FFmpeg Library: I Locate...

FFmpeg Library: | Download

Open the website to download ‘lame_enc.dll’: click on LAME download page.

Windows

1. Goto the ext @
Lefrclick this link, do not night-click.

2. Dwectly undemeath "For FFmpegLAME on Windows click below”, let-click the ink Lame v3.99.3 for Windows.exe and save the file anywhere on your computer.

3. Double-chick "Lame ¥3.93.3 for Windows exe” to launch it (you can safely ignoce any wamings that the “publisher could not be venied”)

4. Follow the Setup instructions to install LAME for Avdackty, making sure not to change the offered installation location of “C:\Program Files\Lame for Audacity™ (or
“C:\Program Files (xB6)\Lame for Audacity” on a 64-bit versicn of Windows)

Yeu showd now bz able to export MP3s without any futher configuration. choosing File > Export Audio... then selecting "MP3 Files™ in the Expot Audio Dislog
Troubleshooting
Occasionally, there may be 3 confict where Audacity stil tnes to detect the path to an older lame_enc dil fle. To comect this
1. Ensure theee are no older versions of lame_enc dll in any lkecations where AvdacRy detects #, namely.
= C:\Program Files\Lame for Audacity or C:\Program Files (x85)\Lame for Audacity {this is whece the installer puts the new di)
« ths Audacity installation folder (usually C'Program Fles\Audacity or C\Program Files (x86)\Audacity), or in the "Plug-ins™ folder inside that.
2. Ext Avdacity and nawgate 1o the audacity.cfg preferences file at
* Windows XP: Documents and Settings\<user name>\Application Data\Audacty'audacity cig
= Windows VistaWindows 7/Windows 8: Usars\<user name>\AppData'Roaming Audacity'avdacity cfy

_|\ In order to see audacity.cfg, you may need to set the operating system to show hidden files and folders. See instructions for Windows 7 and Windows

versions before 7

Jump straight to Windows download’ in the top line. Left click 'Windows download’ and it will jump to the download
chapter for Windows.

Click Here, Windows User -—@ight to Windows downloads™ €m—
Click Here, MAC OSX User ---> Jump straight to MAC OSX downloads

Audacity LAME is free, so you can click ‘libmp3lame-win-3.99.3.zip’ under ZIP OPTION to download. Click Save,
select the Folder you want to save it in, then click Save again to save it.
13



TO DOWNLOAD Lame and FFmpeg for Windows, dlick links BELOW:

If Audacity does not detect LAME, download the ZIP option, extract the files inside to a well known folder, then open Audacity, go to Library
Preferences and configure it to search on the well known folder you extracted the files to.

NOTICE: As of 2014-June-27 Clam Antivirus is showing a false positive for Lame_v3.99.3_for_Windows.exe

Lame_v3.99.3_for_Windows.exe - (SHA256 SUM here)

-win-3.99.3.zig YIssues? Some help HERE)
T —

Close the webpage, then click OK to close the Audacity preference. Minimize Audacity interface, then open the Folder
where you saved the libmp3lame-win-3.99.3.Double click on it, then double click on it again to open. Now left click on
lame_enc.dll. Hold and drag it to your Desktop.

NOTES:
u Once you move it to the Desktop you do not need to do this again.
u After opening lame_enc.dll the first time it may not be necessary to open lame_enc.dll the next time you record.

Go back to Audacity and click on Edit, then Preferences. Click on Libraries in MP3 library. Click on Locate, then click
on ‘Browse’. Click on Desktop, then click on Lame_enc.dll to highlight it. Then click Open.

Click on OK on locate Lame box. Click OK on Audacity Preferences to close and to complete your settings. Now you
can Record, Export and save your favorite music.

6. For detailed information about how to run this program, please click ‘Help’ and click ‘Manual (in web browser)'.

Help
[ Quick Help

|

Screenshot Tools...

Check for Updates...
Audio Device Info...
Show Log...

Generate Support Data...

About Audacity...

7. Adjust the output and input volume to 20% (or 0.2 level).

B Tk 0

NOTE: Because of the variation of different operation systems, the input volume control may not work on some
individual Windows versions. Windows Vista is recommended to ensure the input volume control works properly.

For any queries in regard to ‘Mixer Toolbar’ please visit:
http://wiki.audacityteam.org/index.php?title=Mixer_Toolbar_Issues

RECORDING OPERATION

To download music and save into computer:

1. Place the record on the turntable.

2. Move the tone-arm over to the record to start playing.

3. Click the Record ( ®') button to start recording.

The waves (left and right tracks) will show on the interface.
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4. At end of a song, click the “pause” ( "/ ) button on the computer and press the Stop button on the turntable, move
the cursor to the wave area and left click at the end of the song.

For the next song, replace the album or move tone-arm to another desired song. Press the Play button on the
turntable to start playing the next song. Immediately press the “pause” ( ") button on the computer and downloading
will continue and another R/L track will appear on the interface.

NOTE: Pause button will not work during the recording process if the ‘Sound Activated Recording’ in Preferences
Recording is selected. Clear the checkbox next to ‘Sound Activated Recording’ if you want to manually pause
recording.

5. Repeat steps 3 and 4 until you have finished downloading.

NOTE: Do not click stop button on the computer when continuously downloading songs. Remember to click pause
button in between your desired songs. Press stop button on the computer only when all your desired songs have been
downloaded.

After your have finished downloading, you may play back the songs through your computer. In stop mode, simply click
(' )SKIP TO START button and then the () PLAY button.

TIP: If you press the “stop” button by accident, you can click “Transport” and click “Append Record” and you can
continue to record in the same track.

Transport | Tracks Generate Effect Analyze Help

Play/Stop Space
Play/Stop and Set Cursor Shift+A
Loop Play Shift+Space
Pause P
Skip to Start Home
Skip to End End
Record R
Timer Record... Shift+T

Append Record Shift+R

Overdub (on/off)
Software Playthrough (on/off)
Sound Activated Recording (on/off)
Sound Activation Level...

Rescan Audio Devices

For example, if the “stop” button has been pressed by accident at the end of the first song, do not click anything in
Audacity. Prepare another song, click “Transport” tab and select “Append Record”. The second song will continue to
record on the same track at the end of the first song.

You now have a music download on your computer but the music needs to be saved and converted to WAV, OGG, or
MP3 formats before exporting.

GENERAL PROBLEMS FOR WINDOWS VERSION

1. If you do not have the fluctuating wave on the interface during recording, or the recording sounds unsatisfactory,
adjust the recording volume as follows:

* Click Start in the left corner of the computer, select Settings, Control Panel.
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@ Set Program Access and Defaults

Windows Catalog

Windows Update

L Programs »

Documents

Control Panel

Settings

) Network Connections
/J Search >
%2 Printers and Faxes

Q)) Help and Support a Taskbar and Start Menu

#=] Run...

’ﬂ Log Off abc...

Windows XP Professional

@ Turn OFf Computer...

74 start
¢ In Control Panel interface Find Sounds and Audio Devices. Double click the icon to enter
Sounds and Audio Devices Properties interface.

® Control Panel EJ@[Z|
L

File Edit View Favorites Tools Help

@Back S Q L? /:j Search [L Folders -
E/ Control Panel A 6’ § :@ % 0 :\9 %

Accessibilty  Add Hardware Add or Administrative  Automatic  Date and Time Display
Br Switch ko Category View Options Remov... Tools Updates
. N
@ @ e P &= D @
=, ' 3

Folder Options Fonts Game Internet Keyboard Mouse MNetwork
Controllers Options Connections

L 4% © Q e S

Network Setup  Phone and  Power Options  Printers and QuickTime  Regional and Scanners and

Wizard Modem ... Faxes Language ... Cameras
) Y
< ) \ &
Scheduled Security S Speech System Taskbar and User Accounts
Tasks Center Start Menu
VMware Tools  Windows Wireless

Firewall  Network Set...

* In Sounds and Audio Devices Properties interface

Volume window will display, select the Audio tab to reveal the settings.

In Sound recording, select USB PnP Audio Device and click the Volume button to set the recording input level. The
WAVE IN window will appear.

Sounds and Audio Devices Properties

Volume Sounds

Sound playback

Voice | Hardware

Default device:
| USB PnP Audio Device v

[ voume. ][ Advanced.. |

Sound recording

Default device:

¢ )
[ USB PnP Audio Device v
p——
r Yolume... , Advanced...
N’

MIDI music playback

% Default device:

L l Microsoft GS Wavetable Sw Synth v \
[ Yolume... ] { About... ]
[ Use only default devices

[ 0K ][ Cancel ] Apply

* In WAVE IN interface Adjust the recording volume to about 50% as per illustrated below.
The fluctuating wave will show on the interface when recording.
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Options Help

Microphone

Balance:

B —{— d

Yolume:

T

[ Mute

USB Audio Controller

2. If you do not hear any sound when the turntable is connected and you wish to listen to the music and /or video, it is

possible that the default playback device has been changed to USB PnP Audio Device when the turntable connects to
the PC.

Recommended: Remove the USB cable from the PC.

Alternative: This solution requires you to change the setting manually every time you connect the USB cable to the PC.
Change the setting as follows:

*For Vista and s =
Windows 7 users:

Pleyback | Recerdng | sounds | Communicatens
Click “Start” and go to the Control Panel. Find and
click “Sound” icon. Sound window will be opened
and the “Playback” window will be seen. You will <
see that the Speaker USB PnP Audio Device is set

Select 2 playback device below to mody Its settings

Speaker
Igh Detinttion Audio

as default. To ensure the sound, click a playback { ) Headphones
device (e.g., Speaker High Definition Audio), then ({ @ Mot plugged in
click “Set Default” and click OK. The sound should Digital Audio (SPDE)

now work. =P tigh Defint

. Speaker
P USE 2nP fwdo Device
0 Defaull D v =

| Configure @ Properties
=

*For Other Windows
verSions users Voiume Scunds Veice Hardwae
(e.g.: Windows XP):

Sounds and Audie Devices Properties

Click “Start” and find “Settings”, “Control Panel”. In @y Delaut devies

the Control Panel window, find and double click into R ISELEDEL Sk Eevice S
“Sounds and Audio Devices”. In the Sounds and Volwe. || adanced .|
Audio Devices Properties window, Volume window R

will be seen. Click the “Audio” tab to reveal the } Dolsuk dovioa

settings. In the Sound playback section, you will AR T s6 Prp Audic Device =
see that the USB PnP Audio Device is selected. o \rr—

To enable the sound, click the pull-down arrow and
select your inbuilt sound device or sound card by N IC v
name as the playback device (e.g., Realtek) and il o

. wassss’  Mizrozok GS Wavetable SW Sprih ~
click OK and the sound should be enabled.

[ Valume.. ] : sboul.. ]

[T Us= cely defaut devces
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DIVIDING TRACKS

After you have finished downloading, you may play back the songs through your computer before exporting. In stop
mode, simply click () SKIP TO START button and click then the ( /) PLAY button.

1. Press (' ) button to return to the beginning of the first song.

2. Move cursor to the wave graphic area, left click mouse and hold then drag from left to right. Release the mouse
when the highlight reaches the end of the first song.

Highlighted

3. Click "File" tab then select "Export Selected Audio..."
File | Edit View Transport Tracks Generate Effect Ana

New Ctrl+N

Open... Ctrl+O

Recent Files >

Close Ctrl+W
Save Project Ctrl+S
Save Project As...

Save Compressed Copy of Project...

Check Dependencies...

Edit Metadata...
Import »

Export Audio... Ctrl+Shift+E
Export Selected Audio...

Export Labels...

Export Multiple... Ctrl+Shift+L
Export MIDL...

Apply Chain...
Edit Chains...

Page Setup...
Print...

Exit Ctrl+Q

4. In the next window, select a location as well as the format (most people prefer to save audios in MP3 format (MP3
format is most common)) in My Music and put the title in the file name. Click “Save”.

NOTE: The most common formats are: MP3, WAV (WAV uses a lot of space), and MYA/AAC

(most iPod devices can play audios with this format).

You can also choose alternative formats such as AIFF, WAV, OGG or FLAC if these formats are supported on both
your computer and the exported devices. Note that according to your selection, the Edit Metadata window may not
appear.
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a Export Selected Audio n

S o =

Savein: (1) My Musc - @# @
No items match your search.
o

Recent Places

"

Desktop

Libraries

Computer

€A

Network

File name track 01.mp3 v Save
Save as type. MP3 Files - Cancel

Options

5. In the next window, fill in the information in the window entitled “Edit Metadata”. Then click “OK”.

Edit Metadata ﬂ
Use arrow keys (or ENTER key after editing) to navigate fields.

Tag Value
Artist Name
Track Title
Album Title
Track Number
Year

Genre
Comments
Genres Template
Edit... Reset... Load... Save... Set Default

Concel

Wait a few seconds before exporting the selected audio.

track 01

2 |
Exporting selected audio at 128 Kbps

Elapsed Time: 00:00:01
Remaining Time: 00:00:06

[ Stop ][ Cancel ]

Second song to be divided and saved:

1. Move cursor to the wave graphic at the beginning of the second song. Left click mouse and hold then drag from left
to right until you reach and highlight the end of the second song.

2. Click "file" tab then select "Export Selected Audio...".

3. Follow above steps to divide songs, export and save, one-by-one.

MP3, WAV AND OGG FORMAT

THESE ARE DIGITAL FILE FORMATS FOR AUDIO (MUSIC) AND MOST CURRENT COMPUTERS ARE COMPATIBLE.
HOWEVER, IF YOU COPY THE FILE ONTO A CD DISC (CD-R OR CD-RW) AND PLAY WITH ANOTHER CD PLAYER,
YOU HAVE TO MAKE SURE THE CD PLAYER SUPPORTS THOSE FORMATS; OTHERWISE, THE COPIED CD DISC
WILL NOT PLAY. THE SAME THING IS TRUE WITH A COPIED FILE TO BE PLAYED ON ANOTHER MP3 PLAYER.
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EXPORT AND SAVE FOR WAV
AND OGG FORMATS

(AFTER RECORDING IS COMPLETE)

When the song is finished, click () on the screen to stop playing.
You can export and save tracks individually, or export and save into one file.

To export and save individually:
1. Highlight the song that you want to save then click the file tab on the audacity interface.

File | Edit View Transport Tracks Generate Effect Ana

New CrleN -
Open cwls0
Recent Files »
Close CtrlsW
Save Project Crlss
Save Project Ac.

Save Compressed Copy of Project.
Check Dependencies.

Edit Metadata

Import B
Export Audio Crrl o Shift 4 E
Export Selected Audio...

Export Multiple... CulsShiftsL 2. Select “Export Selected Audio...”,
: ; } - a window will appear as below:
Apply Chain.
Edit Chains.
Page Setup.
Print.
Exit crleQ
o Export Selected Audio “
Save in ¥ My Music ~ © 7T i =~
No items match your search.
o
Recent Places
Desktop
Libraries
Computer
a
t’ _ File name v Save
Network
Save as type MP3 Files @ Cancel
Options

Select the folder, put title in the file name and click the pull-down arrow to select a save type, such as WAV or OGG
format.

3. Choose the file format of the recording that should be exported and put in the title in the file name and the folder of
the location where it will be saved, i.e. desktop. Then click “Save”.

4. Edit Metadata window may appear, complete the information then press the OK button.
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Edit Metadata | < |
Use arrow keys (or ENTER key after editing) to navigate fields.
Tag [ Value |
Artist Name
Track Title
Album Title
Track Number
Year
Genre
Comments
[ Add J | Remove | I Clear ]
Genres Template
Edit... ] I Reset... ] | Load... | l Save... ] l Set Default |
l OK l | Cancel |

5. Wait for a few seconds until the export & saving is completed.

Setting the language

1. Click Edit and select Preferences.

File | Edit View Transport Tracks Generate Effect

Undo Track Remove Ctrl+2Z
Redo Ctrl+Y

) Cut Ctrl+X

“J Delete Ctrl+K
Copy Ctrl+C
Paste Ctrl+V
Duplicate Ctrl+D
Remove Special »
Paste Text to New Label Ctri+AltsV
Clip Boundaries 4
Labeled Audio »
Select »
Find Zero Crossings v/
Move Cursor >

Region Save

Region Restore

Play Region >
:P«d«ems_ Curl+P

2. Another window titled with Audacity Preferences will appear. Click the Interface tab and click the pull down arrow to
select the language you wanted.
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Devices Display
— Playback /] Ergonomic order of Transport Toolbar buttons
Recording 1 Show "How to Get Help' dialog box at program start up

- Quali LEtEL ST DS (o)
Meter dB range: -60 dB (PCM range of 10 bit samples)

= Tracks

- Spectrograms - oo
= Import / Export Location of Manual: From Internet

Extended Import
- Projects
Libraries

Language: ‘English

Behaviors

[ Beep on completion of longer activities
[1Show track name in waveform display
[_]Retain labels if selection snaps to a label edge

- Directories
Warnings
Effects

-~ Keyboard
Mouse

~Modules

Devices Display
— Playback W] Erg ic order of Transport Toolbar &

Recording 1 Show "How to Get Help® dialog box at program start up
- Quality R LR IR I YRl 1 AR SL
- Interface Meter dB range:  -60 dB (PCM range of 10 bit samples)

Tracks

Language: English
—Spectrograms
Import / Export Location of Manual:

Extended Import

Espanol
Behaviors Euskara

- Projects Farsi
Libraries
- Directories [")Show track name Gaeilge

[JBeep on completic . ..o

[IRetain labels if se|Galician
|Georgian
Effects S
-~ Keyboard Hindi
Mouse Htaliano
~Modules Khmer
Korean
Lietuviu
Magyar
Makedonski
Nederlands
Nihongo
Norsk
Occitan
Polski
Portugues
Portugues (Brasil)

~Warnings

Serbian (Cyrillic)

Serbian (Latin)
Audio Position: Slovak
5 | Bowo0 = Slovenscina
| 1SRRG Suomi v

3. Then click OK to close the window. The new setting will only be active in the next start - that means you need to
close the Audacity and re-open the software again.

AUDACITY FOR MAC USERS

System Requirements
Audacity for Mac is a Universal Binary for OS X 10.6 and later. Audacity runs best with at least
1 GB RAM and a 1 GHz processor (2 GB RAM/2 GHz on OS X 10.7 and later).

For lengthy multi-track projects, we recommend a minimum of 2 GB RAM and 2 GHz processor (4 GB RAM on OS X
10.7 and later).
1. Please insert the Audacity software disk that comes with your unit. Click the Audacity disk on the desktop.

2. Select Audacity_for_mac for Macintosh system.
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8 00 (5) AUDACITY

Audacity Audacity-for-mac Audacity-for-win

TIPS: To check your computer OS version, you can click the Apple icon then select “About This Mac”.

Finder File Edit View Go Window Help

The next window will display and the processor type and the OS version will display as below.

800 About This Mac

\ %

\ /

S

Mac OS

Version 10.7.3

| Software Update... |

Processor 2 GHz Intel Core 2 Duo
Memory 2 GB 667 MHz DDR2 SDRAM
Startup Disk Macintosh HD

( More Info... |

TM and © 1983-2012 Apple Inc.
All Rights Reserved. License Agreement

3. Double click on the Audacity_for_mac folder.

Audacity-for-mac

4. Then double click "audacity-macosx-ub-2.1.2.dmg".

audacity-mecosx-ub=2.1.2 dmg

Wait a few minutes until this window disappears.

Opening "audacity-macosx-ub-2.1.2.dmg"...

[ ] | Cancel |

Verifying... [ skip |

Then another window will appear.
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enn _ Audacity 2.1.2

D Audacity

INSTALLATION
Drag the A ity folder to the Applicati shortcut
A
»
Audacity Applcations

Drag the "Audacity" folder in to "Applications" as the instruction show on the window.

5. Double click the Audacity folder and in the Audacity window, files will be displayed in the folder.

8 00 (] Audacity

! ,1‘ "" "
WA

Audacity

4 Date Modified

Jan 13, 2016 2:27 AM Application
» [ help Jan 13, 2016 2:33 AM - Folder
7 Install.txt Jan 13, 2016 2:33 AM 719 bytes Plain...cument
| LICENSE.txt Jan 13, 2016 2:33 AM 19 KB Plain...cument
» (] nyquist Jan 13, 2016 2:26 AM - Folder
» [] plug-ins Jan 13, 2016 2:33 AM - Folder
~ README.txt Jan 13, 2016 2:33 AM 96 KB Plain...cument

6. Double click the Audacity icon to start the software running, alternatively, drag the “orange ball wearing headphones” icon
down onto the desktop toolbar. Click on this icon to run Audacity.
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CONFIGURING AUDACITY FOR MAC

Audacity Interface for Mac

7.0 80 9.0 1 120 130

e e Ause Pmser

P S

Audacity Interface---Settings and controls

At the top of the main Audacity window, to the right of the play control buttons, you will see the input and output level meters
(labeled L and R). Under the output level meter, is an icon that looks like a microphone. Next to the microphone is a black
arrow that points down. Click this arrow and select Start Monitor. (If you do not see the input and output level meters, open
your Preferences again as described above.)
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AUDACITY CONTROLS AND BUTTONS

Use the attribute control button at the top of the screen to go to Beginning, Play, Record, Pause, Stop and End. Use the File,
Edit, View, Transport, Tracks, Generate, Effect and Analyze menus to Save, Export, and Edit the music.

1. Clickthe ( '—— ) button to skip to start;

2. Clickthe ( — ) button to play;

3.  Click the ( e ) button to record;

]
4. Clickthe ( . ) button to pause the recording;

5. Click the ( '—— ) button to stop the recording;
6. Click the ( _ ) button to skip to end;

7. Input level monitor

8. Output level monitor

9. Input device

10.  Output device
11.  Adjust the input volume.
12.  Adjust the output volume.

123456 7 8
e | "| | | | | Audacity
T2 6| |- AL -5+ s {cicciosan vonioring} ~i2—~6—0)||- ) L84 —ds 423630 -d4—-is~iz 60
il e | Ple kx -1 b 5] © 22
CoreAu... 3 J3' Built-in Microphone & | 2 (Stereo) | +| 49 Built-inOcfut 3 L@ b
- 10 |P Lo 2.0 % ' | 0 50 s 6.0 7.0 8.0 ; 9.0 100 110
9 1 10 12

AUDACITY PREFERENCES SETTINGS

A few settings will be required before you download the music.
1. Click “Audacity” on the Audacity interface, select “Preferences” and another window will appear on the screen.

File Edit
About Audacity...

" Preferences...y %,

.. Services >

®
)F

v o

-

. Hide Audacity %H
) 1 Hide Others Y %H

-

Quit Audacity #Q
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[0 0

Preferences: Devices

| Devices |
Playback
Recording
Quality
Interface
¥ Tracks
Spectrograms
¥ Import / Export
Extended Import
Projects
Libraries
Directories
Warnings
Effects
Keyboard
Mouse
Modules

Interface

Host: | Core Audio

Using: PortAudio V19-devel (built Jan 12 2016 13:27:02)

Playback

Device: | Built-in Output A
Recording

Device: | Built-in Microphone 3|
Channels: | 2 (Stereo) Al

Cancel

ok

2. In the window of Audacity Preferences click “Devices” on the left hand side.

Then on the right side within the Recording Device column, set Device to “USB PnP Audio Device”, Channels to “2

(Stereo)”.

NOTE: If you cannot find the " USB PnP Audio Device" in the Device list, close the Audacity Software and re-open and
try again. Ensure that the turntable is connected to the computer.

[@ 006

Preferences: Devices

Playback
Recording
Quality
Interface
¥ Tracks
Spectrograms
¥ Import / Export
Extended Import
Projects
Libraries
Directories
Warnings
Effects
Keyboard
Mouse
Modules

Interface

Host: | Core Audio

Using: PortAudio V19-devel (built Jan 12 2016 13:27:02)

Playback

Device: | Built-in Output e

Recording

Device: | USB PnP Audio Device %

Channels: | 2 (Stereo)

“

Cancel

3. Click “Recording” on the left. Then on the right side in Playthrough column, click the checkbox beside “Software
Playthrough: Listen while recording or monitoring new track”.

In the Sound Activated Recording column, click the checkbox beside “Sound Activated Recording”, then slide the
meter to -36 db. NOTE: Once the ‘Sound Activated Recording’ is selected, the Pause button will not work during

recording.
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160006 Prefe}é;aces: Recording

Devices L
Playback | Overdub: Play other tracks while recording new one
' Hardware Playthrough: Listen while recording or monitoring new track
Quality | Software Playthrough: Listen while recording or monitoring new track
Interface
¥ Tracks Latency
Spectrograms

v Import / Export Audio to buffer: 2 milliseconds (higher = more latency)

Extended Import Latency correction: -150 milliseconds (negative = backwards)
Projects
Libraries Sound Activated Recording
Directories 7' Sound Activated Recording
Warnings
Effects Sound Activation Level (d8):
Keyboard -36 -36 0
Mouse
Modules

Cance

4. Click “Quality” on the left then on the right side in the Sampling column, select “44100 Hz” in Default Sample Rate
and select “16-bit” in Default Sample Format.

e 06 : Pref=erences: Quality
Devices Sangiug
Playback Default Sample Rate: 44100 Hz 4| 44100
Recording ) "
Default Sample Format: [ 16-bit v]
Interface Real-time Conversion
v Tracks
Spectrograms Sample Rate Converter: [ Low Quality (Fastest) v ]
¥ Import / Export Dither: [ Rectangle :]
Extended Import
Projects High-quality Conversion
Libraries Sample Rate Converter: [ High Quality &l
Directories
Dither: Triangl v
Warnings ither: [ riangle ]
Effects
Keyboard
Mouse
Modules

[ cancel | [0k

5. Click “Libraries” on the left then on the right side in MP3 Export Library column, check if the program has detected
and shown the MP3 Library Version there. If shown, skip and forward to
step 6.
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8 0 0 Preferences: Libraries i

Devices MP3 Export Library
Playback MP3 Library Version: LAME 3.98.2
Reco.rding MP3 Library: [W
ﬁ‘t‘:l'f:’ce LAME MP3 Library: | Download |
FFmpeg Import/Export Library
Spectrograms

FFmpeg Library Version: FFmpeg library not found

FFmpeg Library: | Locate... |

FFmpeg Library: | Download |

¥ Import / Export

Extended Import
Projects
Libraries

Directories [

Warnings |

Effects |

Keyboard |

Mouse |

Modules :

|

|

|

|

|

|
|
|
|
|
|
¥ Tracks |
|
|
[
|
|

[ Cancel | [0k ]

If “MP3 export library not found” is displayed, you must find the “LAME”. Click “Locate...” button then a window named
“Locate Lame” appears to find where the “LAME” is. Click the “Browse...” button to find it.

Sl ) _Locate Lame

Audacity needs the file libmp3lame.dylib to create MP3s.

Location of libmp3lame.dylib:
[Vusr/local/Iib/audacity/libmp3lame.dylib ] (Browse...)

To get a free copy of Lame, click here -->
(Cancel) 6 oK —)

If you cannot find it or the LAME file you found is not compatible, click the “Download” button and a website will show
automatically. Scroll down the webpage to find a title named “Mac OS X”. Click the “LAME download page” and
another website will show automatically.

Mac OS X

On OS X 106 or later, Admiistrative (and occasionally. 100t) permissions may be needed on some machings to read the LAME hbrary the installer places in
lusrlocalib/audacty

In case of dfculty, please downlead the 2ip veesion “Lame_Library v3.98 2 for_Audacity_ea_OSX zip" from “Altemative 2ip dowsload for Lame 398 2° below and
follow the instructions

« Installer

Goto the er.
Download Lame Library vIS8Z for Audacity on 0SX.dmg

When you have finished downleading. double-cick the dmg to mount 2, thea 9o to the Finder (n Safan, the “Lame Library v3.98 2 for Audacity” vitval disk image will be
extracted and mounted automatically aher downloading)

Dowble<fici "Lama Library v3.98 2 for Audacity. pig”, the standard OS X Installer wil stad

Cick theough the stegs in the Installer, accepting the defauks i all cases, this wil mstall the LAME binary idep3iame dyib” in /usehecalibiaudacty

6. Audacy shoud detect LAME automatically whin you ¢xpod as MP3 I Audacy cannct fnd LAME

1. Chck Audacity > Preferences then chooss "Liteanies” on the keh

2. Chck "Locate . under "MP3 Expont Liteary”, then "Browse...” i the "Lozate Lame” dislog

3. The "Wheee is libmptame dylib?" window will open at Justilocalib/audactty, select Tomp3lame dyid”, click "Open” then "0K” and "0K”

D

o e

Find and Click the "MAC OSX downloads"

29



Click Here, Windows User --—> Jump straight to Windows downloads

Click Here, MAC OSX User ---> Jump straight td{MAC OSX downloads

Scroll down the webpage.

For FFmpeg and LAME on Mac OSX click below:

If Audacity does not detect FFmpeg, download the ZIP option, extract the files inside to a well known folder, then open
Audacity, go to Library Preferences and configure it to search on the well known folder you extracted the files to,

For Audacity 1.3.3 or later on Mac OS X 10.4 and greater (Intel or PPC),and Audacity 1.2.5 on 0S X 10.4 and

later (Intel
P versaon

ame Library v3.98.2 for Audacity on OSX.dm3
FFmpeq 2.2.2 ZIP for Audacity 2.0.6 or later on OS X 10.4 and later (Intel or PPC) (THIS IS NOT LAME!):

fimpeg-mac-2,2.2.2ip - DMG version here

FFmpeg Binary for Audacity 1.3.13 to 2.0.5 ONLY (see previous link for 2.0.6) 0S X 10.4 and later (Intel or
PPC):
FEmpeq (0.6.2 0SX 10.4+ DMG) (2ip version here or if problems with the installer, try this new one)

You will notice a form showing the LAME for all version systems. Find a title named “For Audacity 1.3.3 or later on Mac
OS X 10.4 and greater (Intel or PPC), and audacity 1.2.5 on OS X 10.4 and later (Intel)” and then click “Lame Library
v3.98.2 for Audacity on OSX.dmg” or "here" to download the file. Then locate LAME and click OK.

8.0.0 Locate Lame

Audacity needs the file libmp3lame.dylib to create MP3s.

Location of libmp3lame.dylib:

To get a free copy of Lame, click here --> [ Download )

6. Click OK to close the Preferences interface.

SETTING THE RECORDING INPUT LEVEL

It is recommended that the recording input level is adjusted prior to starting to record.
Slide the output level to about 0.5, slide the input level to 0.3, then get your record ready.

Yl R S)
RECORDING OPERATION

To download music and save into computer:

1. Place the record on the turntable.

2. Move the tone-arm over to the record to start playing.

3. Click the Record (' @ ) button to start recording.

The waves (left and right tracks) will show on the interface.
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4. At end of the song, click “pause” ( '_') button on computer and press Stop button on turntable, move cursor to the
wave area and left click at the end of the song.

For the next song, replace the album or move tone-arm to another desired song. Press Play button on the turntable to
start playing the next song. Immediately press “pause” (') button on computer and downloading will continue and
another R/L track will appear on the interface.

NOTE: Pause button will not work during recording process if the ‘Sound Activated Recording’ in the Preferences
Recording is selected. Clear the checkbox next to the ‘Sound Activated Recording’ if you want to pause recording
manually.

5. Repeat steps 3 and 4 until you have finished downloading.

NOTE: Do not click stop button on computer while continuously downloading songs. Remember to click pause button
in between your desired songs. Press stop button on the computer only when all your desired songs have been
downloaded.

After your have finished downloading, you may play back the songs through your computer. In stop mode, simply click
(“ ) SKIP TO START button then the () PLAY button.
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DIVIDING TRACKS

1. Press (™ ) button to return to the beginning of the first song.

2. Move cursor to the wave graphic area, left click the mouse and hold then drag from left to right. Release the
mouse when the highlighter has reached the end of the first song.

3. Click "File" tab then select "Export Selected Audio...".

4. The window will pop up a dialog box for you to complete the Metadata. Click OK button when completed.

New 8N

Open... #0
Open Recent >
Close £
Save Project S

Save Project As...
Save Compressed Copy of Project...
Check Dependencies...

Edit Metadata...

OXE

Export Multiple... 8L

AP

Apply Chain...
Edit Chains...

Page Setup...
Print...

5. Then a window appears, select your music file location and format and type in your file name. Click “Save” and the
song is saved on the computer.

Save As: track 1| \Z\
| PY—
[« = JE (&abum + @
FAVORITES
1/.\ Applications
(£ Audacity
@ Documents
E Desktop
€ Downloads
H Movies
J7 Music
Pictures Other uncompressed files
AEncEs 1 AIFF (Apple) signed 16 bit PCM
WAV (Microsoft) signed 16 bit PCM
GSM 6.10 WAV (mobile)
Form: | | Options... |
Ogg Vorbis Files
| FLAC Files [
| New Folder | MP2 Files [ Cancel |
(external program)

M4A (AAC) Files (FFmpeg)

AC3 Files (FFmpeg)

AMR (narrow band) Files (FFmpeg)
WMA (version 2) Files (FFmpeg)
Custom FFmpeg Export
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6. Edit Metadata window will appear. Complete the information then click OK. Wait for a few minutes until the saving is
complete.

800 Edit Metadata
Use arrow keys (or RETURN key after editing) to navigate fields.

Tag Value =
[Artist Name |
Track Title
Album Title
Track Number
Year
Cenre
Comments

| Add || Remove | | Clear |
Genres Template
\7 Edit... | | Reset... | [ Load.. | | Save... | | SetDefault |
| Cancel | [ OK | |

EXPORT AND SAVE FILES (AFTER RECORDING
IS COMPLETED)

When the recording is finished, click the ( .= ) on the screen and stop the cassette playback.

u You have a music download on your computer now.

u You may play back the song through your computer.

] Simply click the ( ) to play.

1. To export and save individually, click the “File” tab on the Audacity window then select
“Export Selected Audio...”.

Y Edit View Transport Tracks |

New #N
Open... %0
Open Recent >
Close 8’W
Save Project 8S

Save Project As...
Save Compressed Copy of Project...
Check Dependencies...

Edit Metadata...
Import >

Export Audio... O HE

CLxport Selected Audio..
Export Multiple... 8L
Apply Chain...
Edit Chains...

Page Setup...
Print...

33



To export and save into one file, click the “File” tab on the Audacity window then select

“Export Audio”.
New #N
Open... %0
Open Recent >
Close BW
Save Project #8S

Save Project As...
Save Compressed Copy of Project...
Check Dependencies...

Edit Metadata...
Import >

oKE
Export Selected Audio...

Export Labels...
Export Multiple... 8L
Export MIDI...

Apply Chain...
Edit Chains...

Page Setup...
Print...

2. A window will pop up after clicking Export. It will default to the MP3 format, but you also can select other formats by
clicking the arrow located at the right of the MP3 Files.

__Audacity
' Save As: |track 1 ‘ EJ
<> | ::Elm] [ £3 album i) @
FAVORITES | Name | Date Modified
DEVICES
Other uncompressed files
AIFF (Apple) signed 16 bit PCM
WAV (Microsoft) signed 16 bit PCM
GSM 6.10 WAV (mobile)
Form Options...
Ogg Vorbis Files
( FLAC Files —
New Folder MP2 Files Cancel @

(external program)
M4A (AAC) Files (FFmpeg)

AC3 Files (FFmpeg)

AMR (narrow band) Files (FFmpeg)
WMA (version 2) Files (FFmpeg)
Custom FFmpeg Export

3. Complete the “Save As” and Save-in location, click the Save button and the Edit Metadata window will display.
Complete the information if necessary then click OK and wait a few minutes until it is finished saving.
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8.0.0 Edit Metadata
Use arrow keys (or RETURN key after editing) to navigate fields.
Tag Value
Track Title
Album Title
Track Number
Year
Cenre
Comments
Add Remove Clear
Genres Template
Edit... Reset... Load... Save... Set Default
8 0 0O track 1
Exporting selected audio at 128 Kbps
Elapsed Time: 00:00:07
Remaining Time: 00:00:24
Stop Cancel

TROUBLESHOOTING GUIDE

If you experience any problems with your unit, kindly consult the following guide prior to calling your dealer.

NO SOUND:

« If you are not getting any sound into the software application, go back to the preferences as shown above and make sure
that you have selected the USB PnP Audio Device for the recording device in the devices.

» Power Cycle: Close Audacity, turn off the turntable, unplug the USB Cable. then plug in the USB Cable, turn on the turntable
and reopen Audacity.

« If you are not able to hear any audio as you play the record, please click on the microphone drop-down arrow and select
Start Monitoring. This will enable you to hear the audio from the turntable, even if you have not record-enabled the Audacity
application.

Ll ' ' FFErian Tl T T Tl Ui A 8 1) ' 0
A2 =33 -30 -27 Click 10 Start Monitoring |-9 6 =30
itori = \
Start Monitoring . e +
.~ Preferences... | =
o... FWT BUN=1n Uutput s |

Check the microphone slider to make sure that it is at full volume, all the way to the right as shown below. If you find the
recording sounds low or distorted, adjust the microphone slider.

- —_—

« If you still do not have the fluctuating wave on the interface during recording, or the recording sounds unsatisfactory, adjust
the recording volume as follows:

Click the launchpad icon
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Then find “System Preference” and double click it.

System Preferences

In the new interface, find the “Sound” icon and double click it.

Q

Sound

Adjust the Output volume under “Sound Effects”

80eo Sound

mlzia’ Output | Input |

Select an alert sound:

Name Type
Built-in
Blow Built-in
Bottle Built-in
Frog Built-in
Play sound effects through [ Internal Speakers :]
Alert vol ),
N )
[_] Play user interface sound effects
("] Play feedback when vol is ch d @
Output vols ) Mut
oo | )

oW volume Iin menu

Under “Input”, select “USB PnP Audio Device” and adjust the “Input volume”

(X Ne] Sound

| Sound Effects | Output lm’

Select a device for sound input:

Name Type

Internal microphone Built-in
Line In
Sl USB PnP Audio Device

Audio line=in port

Settings for the selected device:

Input volume: l!g_ #@I Qg

inputleve: Q0000000000000

Output volume: * Q ‘))) (] Mute

@Shuw volume in menu bar

POOR SOUND QUALITY:
» Check your stylus to make sure it is secured to the tone arm. The stylus must be connected
to the tone arm whenever using the turntable.

» Make sure that your RCA plugs are plugged into a source or not touching bare metal. If you are experiencing noise
through the USB, you may have interference from the RCA plugs. Ensure the USB cable is not touching or near any
other cables.

« If you experience any odd sounds coming from the recording, try closing all applications and restarting the computer.
Only run Audacity while recording.
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Problem

Cause

Solution

Power does not come on
when the unit is
switched on.

Unit is unplugged.

Connect the unit to the
AC power supply.

No sound comes out of

The volume is turned

down (to MIN).

Adjust the volume.

time.

-
Z | thespeakers. The input selector does )
= Re-select the desired
w not match the playback |
o input source.
I source.
S
w
':l_: The unit is too close toa | Turn off the TV or other
The sound is noisy. TV set or another similar | appliance, and relocate
appliance. the unit.
Remove the power cord
External factors such as
. ) and all power supply to
The unit has no ESD (Electro-static ]
] the device, then re-plug
response. discharge) affect the ] )
) in the unit after one
unit. )
minute.
- The sound is noisy when | The stylus is not placed Place the stylus in the
E playing the record. in the middle center. middle center.
a
(@)
g The sound is noisy when Please change to a new
z used for a period of The stylus is damaged. stylus.
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USB-PC

No sound.

“USB PnP Audio Device”
may not be selected
when choosing a
Recording Device during
the Device Audacity
Preference Settings.
Make sure the
Microphone slider it is

not at full volume

Go back to the
preferences as shown
above and make sure
that you have selected
the “USB PnP Audio
Device” for the
Recording Device in the
Device Audacity
Preference Settings.
Close Audacity, turn off
the turntable and unplug
the USB Cable. Plug the
USB Cable in after a
moment, turn on the
turntable and reopen
Audacity.

Click on the microphone
drop-down menu and
select Start Monitoring.
Adjust the microphone
slider.

Poor sound quality

The stylus does not have
a great connection to
the tone arm.

The RCA Plugs and/or
USB Cable may be
touching other
interfering wires or may
be unplugged.

Check your stylus to
make sure it is secured
to the tone arm.

Make sure that your RCA
plugs are plugged into a
source or not touching
bare metal. If you are
experiencing noise
through the USB, you
may have interference
from the RCA plugs.
Ensure the USB cable is
not touching or near any
other cables.
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Specification

USB

B NV 1T SRRSO USB series B connector
RECOIAING....cvieiieeieeeiee et eeans USB to PC record for vinyl record
FUII-SPEEM....uiieieeieeeeeeree et eranans USB 2.0 full speed
PHONOGRAPH section

MOTOT ..ttt DC servo motor

Drive SYStEM....cucece ettt st e Belt drive

Y eJ=T=Te £SO 33 1/3 rpm, 45 rpm and 78 rpm
WOW & FIUTEET ..o Less than 0.25% (WTD)

A\ I =1 [ TN More than 35 dB

Cartridge tYPe.. et et Ceramic stereo cartridge

SEYIUS ettt e et et st ITRRS-300

OULPUL [@VEL..ecei et 160-380 mV (5 cm/sec at 1 KHz)

GENERAL
Power requirements........ccccceevveveeiecvercvevee e AC 120V ~ 60 Hz
Power consumption.......ccocccceveenecceiniensieeeenenes 5wW
Dimensions (LXDXH) ....ceevvveeeeevercereerivece e 360mm(L) X 221.6mm(D) X 105mm(H)
LAY = o TR 1.76 kg (approx.)
Standard accesSOries.......coverieeireeneeecee s Instruction Manual
45 RPM Adaptor
A Disc for Audacity Software Driver
USB Cable
RCA Line-out Cable

Made in China.

*As a result of continual improvements, design, specifications, and manual are subject to change
without prior notice.
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FCC Statement

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interference, and (2) this device must accept
any interference received, including interference that may cause undesired operation.

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates
uses and can radiate radio frequency energy and, if not installed and used in accordance with the
instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning
the equipment off and on, the user is encouraged to try to correct the interference by one of the
following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that
to which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

WARNING: Any changes or modifications not expressly approved by the party responsible for
compliance could void the user's authority to operate this equipment.

The device must not be co-located or operating in conjunction with any other antenna or
transmitter.

This device complies with FCC and IC radiation exposure limits set forth for an uncontrolled
environment.

The device should be installed and operated with a minimum distance of 20cm between the
radiator and your body.

INDUSTRY CANADA

This device complies with RSS247 of Industry Canada. Cet appareil se conforme a RSS247 de

Canada d'Industrie.

This device complies with Industry Canada license-exempt RSS standard(s). Operation is subject to the
following two conditions: (1) this device may not cause interference, and (2) this device must accept
any interference, including interference that may cause undesired operation of the device. appareils
radio exempts de licence. Son fonctionnement est sujet aux deux conditions suivantes: (1) le dispositif
ne doit pas produire de brouillage prejudiciable, et (2) ce dispositif doit accepter tout brouillage recu,
y compris un brouillage susceptible de provoquer un fonctionnement indesirable.

Radiation Exposure Statement: The product comply with the Canada portable RF exposure limit set
forth for an uncontrolled environment and are safe for intended operation as described in this
manual.

The further RF exposure reduction can be achieved if the product can be kept as far as possible from
the user body or set the device to lower output power if such function is available.

Déclaration d'exposition aux radiations : Le produit est conforme aux limites d'exposition pour les
appareils portables RF pour les Etats-Unis et le Canada établies pour un environnement non controlé.

Le produit est sGr pour un fonctionnement tel que décrit dans ce manuel. La réduction aux
expositions RF peut étre augmentée si I'appareil peut étre conservé aussi loin que possible du corps
de I'utilisateur ou que le dispositif est réglé sur la puissance de sortie la plus faible si une telle fonction
est disponible.
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CALIFORNIA PROP 65 WARNING

"WARNING" This product contains chemicals known to the State of California to cause birth
defects or other reproductive harm. For more information on these regulations and a list of
chemicals, log on the following website address:

http://www.oehha.ca.gov/prop65.html
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Innovative Technology Electronics LLC.
Limited Warranty: 90 Days Labor, One Year Parts

Innovative Technology Electronics LLC. (IT) warrants the product to be free from “Defects” in
materials under normal use for a period of “One Year” from the date of the original purchase.
The Warranty is “Not” transferable. IT agrees, within the initial “90 Day” period, to repair or
replace the product if it is determined to be defective at “No Charge”. It is further agreed that IT
will cover the cost to repair or replace damaged “Parts” only for a total period of “One Year” from
the date of the original purchase.

The warranty does not cover cosmetic damage, antennas, AC cords, cabinets, headbands,
ear-pads

or damage due to line power surges, connection to improper voltage supply or settings, misuse,
mishandling, accident, acts of God or attempted repair by an unauthorized service agent.

To obtain service, the purchaser MUST present an original sales receipt / proof of
purchase. Please contact us at www.ithomeproducts.com to request an RMA (Return
Material Authorization) number to return products for service or replacement. Returns
without an RMA number on the package will be refused and returned to sender. Upon receipt of
the returning item and our full inspection (IT) may issue a replacement to customer for the same
item or of one that has equivalent value and features. To return an item, supply full name, return
address, phone number,

item purchased, receipt of purchase and reason for return to obtain RMA number.

All returns must be in the original packaging or reasonable substitute to prevent damage.
Customer “Must” include full name, shipping address and telephone number inside of package.
No return will be shipped back to a PO Box or APO address.

Please include your check or money order in the amount of:

« USD $5.00 for items $10.00 to $39.99 (Price Paid Per Unit)

« USD $10.00 for items $40.00 to $99.99. (Price Paid Per Unit)
« USD $16.00, for items $100.00 and up. (Price Paid Per Unit)
* Shipping fees are non-refundable

to be payable to Innovative Technology Electronics LLC. (for handling and return shipping
charges) (IT) will not be responsible for delays or unprocessed claims resulting from a
purchaser’s failure to provide any / all of the necessary information. Send all inquiries or RMA
request via our website www.ithomeproducts.com/support.

Innovative Technology Electronics LLC.

1 Channel Drive

Port Washington, NY 11050

Toll free: 1-877-483-2497

Website for support: www.ithomeproducts.com/support

There are no express warranties except as listed above.

REPAIR OR REPLACEMENT AS PROVIDED UNDER THIS WARRANTY IS THE EXCLUSIVE
REMEDY OF THE CUSTOMER, (IT) SHALL NOT BE LIABLE FOR ANY INCIDENTAL OR
CONSEQUENTIAL DAMAGES FOR BREACH OF ANY EXPRESS OR IMPLIED WARRANTY
ON THIS PRODUCT EXCEPT TO THE EXTENT PROHIBITED BY APPLICABLE LAW. ANY
IMPLIED WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE
ON THIS PRODUCT IS LIMITED IN DURATION TO THE DURATION OF THIS WARRANTY.
Some states do not allow the exclusion or limitation of incidental or consequential damages, or
limitations on how long an implied warranty lasts, so the above exclusions or limitations may not
apply to you. This warranty gives you specific legal rights and you may also have other rights,
which vary from state to state.
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